Poster Presentation Instructions
Poster Presentation

Overview

• A poster presentation is essentially an overview of your research and everything that you have done thus far.
• We understand that research projects do not start and end on specific dates and therefore, many of you will only have preliminary results.
• For the final poster, you will need to include:
  • The UNLV logo
  • Your name and mentor’s name
  • Grant acknowledgment (if applicable)
• Your research mentor MUST approve your poster presentation. This is an opportunity to learn and ask questions.
• It is highly recommended that you use PowerPoint to set up your poster.
• Templates can be found on the OUR website.
  • On PowerPoint:
    • In the Design tab, look to the far right and click on Slide Size, then Custom Slide Size to adjust to your desired dimensions.
    • You can change the Layout of the slide to Blank and then begin placing text boxes to create your format. In the Insert tab, click on Text Box. Click and drag the mouse on the slide to create the text box.
    • You can import media (images, charts, and icons) by clicking on the Insert tab and then Pictures. Browse to the location on your computer to find the file. You can also drag and drop media directly onto the slide.

• Specifics:
  • The recommended size is 36 inches (height) by 48 inches (width) and Landscape orientation
  • Title: Use at least 70 pt. font
  • Authors and Affiliations: Use at least 50 pt. font
  • Headings: Use at least 40 pt. font
    • Any text under the headings should be at least 24 pt. font.
  • Include:
    • Introduction
    • Objectives and Hypotheses
    • Methods
    • Results
    • Conclusions or Discussion
    • Acknowledgements
WRKY Regulation of Drought Response within Oryza sativa

Sandy Hancefzai, Anne Vilcacuin, Keeley Adams and Dr. Jeffrey Shen

Abstract

Rice is a staple food source for over 50% of the world’s population. With rising populations and changing climate patterns, rice production is threatened. The WRKY protein family is known to play a role in the regulation of drought tolerance. This study aimed to identify WRKY gene homologs in Oryza sativa and characterize their expression in response to drought stress.

Introduction

The WRKY family of transcription factors is known to play a role in the regulation of drought tolerance in plants. The expression of WRKY genes in response to drought stress has been studied in various plant species, but their role in rice is still not fully understood.

Methods

The expression of WRKY genes in response to drought stress was investigated using real-time qPCR analysis. The expression levels of different WRKY genes were determined in rice plants exposed to drought stress conditions.

Results

The expression levels of WRKY genes were found to be upregulated in rice plants exposed to drought stress. The expression pattern of WRKY genes was found to be consistent with their known role in drought stress response.

Conclusion

The expression of WRKY genes in rice plants exposed to drought stress suggests a role for these genes in the regulation of drought tolerance. Further studies are needed to understand the specific functions of these genes in drought response.

Acknowledgments

The authors would like to thank the National Science Foundation for funding this research. The authors also wish to thank the reviewers for their helpful comments.

References


Poster Example
Babies’ preference for Infant-Directed Speech is an indicator for later language development.

Janelle M. Salcedo, Evelyn Flores, Karli M. Nave, Erin E. Hannon
Department of Psychology, University of Nevada, Las Vegas

UNLV
Music Lab

BACKGROUND
- Infants prefer to listen to infant-directed speech (IDS) over Adult-directed speech (ADS) [Cooper & Atkin, 1990]. However, the size of this effect has been inconsistent in the literature.
- We participated in Experiment 1 of the Many Babies Project, a multi-lab replication effort that worked collaboratively to replicate the IDS preference across different infant age groups and testing methods (The ManyBabies Consortium, 2010).
- Secondly, we are participating in a follow-up Many Babies study examining the relation between IDS preference and later language development.

RESEARCH QUESTIONS
1) Do 3- to 6-month-old infants prefer Infant-directed speech (IDS) or Adult-directed speech (ADS)?
2) Is the degree of preference for IDS related to infants’ later language development, at 18-months old or 24-months old?

METHODS
- **Experiment 1:**
  - n = 22
  - Procedure: Single screen preference paradigm
  - Stimuli: 8 IDS and 8 ADS sentences (randomized)
  - IV: Speech Type (IDS or ADS)
  - DV: Looking time (s)
- **Experiment 2:**
  - n = 13
  - Procedure: MacArthur Bates Communicative Development Inventory (MB-CDI)
  - Stimuli: Testing Points: 18 months & 24 months
  - IV: IDS Preference from Exp. 1
  - DV: Vocabulary (MB-CDI)

RESULTS
- **Experiment 1**
  - Preference for IDS
  - Mean looking time (s)
  - **Experiment 2**
  - Preference: IDS (6.1 or IDS+)
  - Vocabulary (MB-CDI)

CONCLUSIONS
**Experiment 1:**
- Infants at 3- to 6-months show a significant preference for Infant-directed speech (IDS) over Adult-directed speech.

**Experiment 2:**
- At 18-months, the degree to which babies preferred IDS was a positive predictor for vocabulary development.
- At 24-months, the relation between earlier IDS preference and vocabulary was still positive, but not as strong.

FUTURE DIRECTIONS
- Complete MB-CDI data collection for infants at age 24 months.
- Investigate the relation between preference for IDS and other language abilities, such as phonology.

REFERENCES:

ACKNOWLEDGEMENTS:
Thank you to the UNLV Infant and Child Music Lab and the families who participated. Thank you to the research assistants and graduate assistants who helped with data collection, with a special thanks to Lindsay Mena for helping with the organization and management of Experiment 2 data collection.
Excavating Monterey In The Ancient Maya City of Caracol

Mayra Araneta, Arlen F. Chase
Department of Anthropology, University of Nevada, Las Vegas

Abstract

Fowl and a half kilometers distant from the Caracol site are structures that form an area known as “Monterey,” named after a Maya residential group in this location. The site was not studied in the 1980s, the name is now applied to the public architecture in this location and used for clarity by residential groups. Archaeological investigations in the area of Monterey at the ancient Maya city of Caracol, Belize were carried out in 2019 by assembling multiple editions that consisted of public buildings and residential groups. The research conducted was part of the 39th field season of the Caracol Archaeological Project.

Methods

- Excavation units/used trenches were set up at six structures surveyed:
  - Poblado Group (Residential) C128B: small eastern/central pyramid
  - C129C: northern building
  - C129D: eastern building
  - Monterrey Public Architecture Group C221B: large building, eastern ground
  - C30C: plaza field for a Maya ballcourt
- Analysis of artifacts: ceramic, lithic and groundstone were conducted along with study of architectural features to determine the use of the buildings and width time periods of when they were constructed and occupied.

Results

<table>
<thead>
<tr>
<th>Operation</th>
<th>Structure</th>
<th>Area Trench</th>
<th>Key Artifacts Recovered</th>
<th>Architecture Findings</th>
</tr>
</thead>
<tbody>
<tr>
<td>218B – C212D</td>
<td>Small Eastern Central Pyramid</td>
<td>2.1 x 2.0 m</td>
<td>Stones, ceramic vessels, obsidian, jade, bone, and shell</td>
<td>Structures, walls, stone, stone platforms, multilevel architecture</td>
</tr>
<tr>
<td>218B – C211C</td>
<td>Vertical Trench in Eastern Pyramid</td>
<td>3.5 x 1.5 m</td>
<td>Stones, ceramic vessels, obsidian, jade, bone, and shell</td>
<td>Structures, walls, stone, stone platforms, multilevel architecture</td>
</tr>
<tr>
<td>218B – C213D</td>
<td>Vertical Trench in Eastern Pyramid</td>
<td>3.5 x 1.5 m</td>
<td>Stones, ceramic vessels, obsidian, jade, bone, and shell</td>
<td>Structures, walls, stone, stone platforms, multilevel architecture</td>
</tr>
</tbody>
</table>

| MPK – C216B | Large Eastern Pyramid | 4.5 x 2.0 m | Stones, ceramic vessels, obsidian, jade, bone, and shell | Structures, walls, stone, stone platforms, multilevel architecture |
| MPK – C217B | Eastern Pyramid | 5.0 x 2.0 m | Stones, ceramic vessels, obsidian, jade, bone, and shell | Structures, walls, stone, stone platforms, multilevel architecture |

| C215C – C216B | Eastern Pyramid | 5.0 x 2.0 m | Stones, ceramic vessels, obsidian, jade, bone, and shell | Structures, walls, stone, stone platforms, multilevel architecture |
| B100 – C215B | Eastern Pyramid | 5.0 x 2.0 m | Stones, ceramic vessels, obsidian, jade, bone, and shell | Structures, walls, stone, stone platforms, multilevel architecture |

Discussion

The excavations produced findings in architecture from all the buildings at Monterey. Some showed a long construction history while others represented single-phase constructions placed directly on bedrock. Recovered ceramic, lithic, and groundstone artifacts (including a stone ballcourt monument) were also an important part of being able to interpret the investigations in terms of the time period of occupation and the various construction efforts.

Conclusions & Future Research

- The 2019 research demonstrated that Monterey was constructed and used from the Late Preclassic through the Terminal Classic Periods.
- The amount of construction effort represented in these data at the time of the Maya collapse around C.E. 900, showed that the surviving population of Caracol might have arisen after the city’s final abandonment.
- Future research on this site will consist of analyzing collected החומריות samples through radionuclide dating sent to a special laboratory. Recovered samples were from sub-operations C221B and C221C.

References


Acknowledgements

Dr. Arlen F. Chase, Dr. David L. Chase, Caracol Archaeological Project, UNLV Office of Undergraduate Research, College of Liberal Arts, UNLV, Dr. Christopher Green, Liza Reid, Perry K. Sprague, Liza Reid, Department of Anthropology, Institute of Archaeology, UCLA, Lees, Caracol, Belize.
Questions can be nerve-racking, however, an engaging presentation should encourage discussion and follow-up questions. Listen attentively and paraphrase the question back to them if you need more clarification. Spend some time when preparing beforehand to think of possible questions that would be asked. **It is okay to not know the answer to a question!** It is *not* okay to “fake” an answer to a question. You can say something like... “I actually do not know the answer to that, but it’s a great question and I will look into it.
Delivery

Speak loudly and clearly
Be concise and complete in your explanations
Talk through each slide, but do not read off the slide
Don’t go too quickly

Be aware of your audience
Repeat key points
Limit jargon and explain any uncommon abbreviations

Look professional
Avoid distractions by emptying your pockets, clearing your presentation space, and focusing on your audience
If you provide handouts, distribute them before or after the talk – not during
Face your audience, not the screen

Prepare beforehand
Practice is crucial for a successful presentation
Rehearse by yourself and in front of friends
Time your talk
Rehearsing will decrease nervousness

Show enthusiasm for your research!
• Poster presenters have an 8 minute time slot:
  • 6 min for their poster
  • 4 min for Q&As
  • 3 min for judges to fill out notes
  • 2 min for transition
• Students are responsible for printing their own posters.
• However, the Office of Undergraduate Research offers a first-come, first-served Poster Printing Grant to cover these costs.
• Please encourage your mentor to attend your presentation.
References

- https://www.apa.org/science/about/psa/2014/02/presenting
- https://services.unimelb.edu.au/__data/assets/pdf_file/0005/470075/Presenting_your_research_Update_051112.pdf
- http://www.tulane.edu/~lamp/pdfs/Presenting_Research_Results.pdf
- https://www.northwestern.edu/climb/pdfs-powerpoints/resources-oral/Intro%20to%20sci%20presentations%20202010.pdf